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The 220 Volts 3 Amperes Three-Phase Induction Motor Drive, 
developed with a particular focus on reliability, robustness and low 
cost. 

 

Features 
 
- Complete 220V-3A power inverter solution 
- V/f Control method implemented by MP3PHAC from Freescale 
- Independent motor supply: 0 to 250V AC or direct DC at 0 to 350V DC 
- Output current up to 3A 
- Input inrush limiter based on 3.5A NTC resistor 
- Overtemperature, overvoltage and overcurrent protection 
- Compact design 
- Test points available to test and further evaluation 
- Available for Personal Computer and Stand-Alone operation mode 
- Opto-isolated USB connection to host computer for control and monitoring 
- Implemented as a two independent PCB: Control Board and Power Stage 
- Two board implementation allow further evaluation 
- Presetting for PWM frequency 5, 10, 15 and 20 kHz 
 

Applications 
- Washing machine 
- Air conditioner 
- Fan 
- Pump  
 

Functions: 
- Sensorless Speed Control 
 
 

Description 
The purpose of the MJ-IMC-LC20-LC21 demonstration board is to present a universal, fully-
tested design consisting of a 3-phase inverter bridge based on the small intelligent smart power 
module FNB41560 and the MP3PHAC MCU. 
 
The MJ-ACMC-LC20-LC21 consists of two boards: Power Stage Board (LC20) and Control 
Board (LC21). The Power Stage Board LC20 can be used with different (compatible) Control 
Boards and Control Board LC21 can be used with different Power Stage Boards. It can be 
helpful for new design equipment debugging and testing.  
 
The Power Stage Board LC20 consists of short-circuit rugged IGBT's with negative 
temperature coefficient. Additional auxiliary functions are undervoltage lockout and smart shut-
down.  
 
The Control Board LC21 can operate in standalone mode (control buttons, the «Start / Stop» 
«Forward / Reverse») and can be connected to personal computer via opto-isolated USB port. 

 



Components 
 
MCU: MC3PHAC  
(Manual and Communication software available at http://www.freescale.com/) 
 
USB: FT232R  
(Manual and Virtual COM driver available at http://www.ftdichip.com/) 
 
POWER: FNB41560  
(Manual and Mounting Guidance available at http://www.fairchildsemi.com/) 
 
 

Connector Description 

Fig. 1. Connector description 
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Wiring 
Wiring diagram represents at fig. 2. 

 

 
Fig. 2. Wiring 

 
The Power Stage Board LC20 contains the 9-pin screw connector for Motor, Power and 
Braking resistor connection. The Control Board LC21 contains the 6-pin screw connector for 
External Control panel connection (which include just two variable resistors 10 kOhm and two 
push buttons) and standard mini-USB connector for Personal Computer connection. 
 
Motor connection 
Motor have to be connected to corresponding pin [U V W]  on the Power Stage Board LC20 
(refer silk screen in the bottom of the board) 
 
Power Connection 
Power Stage Board LC20 has two independent power input for motor [MOTOR POWER]  and 
control circuit [AC220] (refer silk screen in the bottom of the board). 
 
Braking resistor connection 
If Motor operate at hard Start-stop mode important to use Braking resistor to avoid overvoltage 
alarm during motor deceleration. The Resistor have to be connected to corresponding pin 
[Brake]  on the Power Stage Board LC20 (refer silk screen in the bottom of the board). Value 
and Power of Braking resistor have to be select due to application requirements.  
Note. For operating show it is possible to use incandescent lamp (about 60..200 Watt) as a 
Braking resistor 
 
External pushbuttons and variable resistors connection 
It is possible to use internal variable resistors (RV105: “Speed” and RV106: “Acceleration”) 
and buttons (S102: “START/STOP”, S103: “FORWARD/RESERVE”) for control motor 
speed, acceleration, On/Off status and motor direction or connect external pushbuttons and 
variable resistors 10 kOhm to the Control Board LC21 via 6 pin screw connector (refer Fig. 2). 
If external pushbuttons and variable resistors are used, the jumpers JP113 and JP114 are must 
be remove. 
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Personal Computer connection 
Connection to PC is available via opto-isolated USB port which located at Control Board LC21 
(Fig. 2). It is possible to use 'USB type A to Mini-B' standard cable. 
 

Using MJ-IMD-LC20-LC21  
with personal computer 

 
The MJ-IMD-LC20-LC21 can be used in “Standalone Mode” or can be connected to Personal 
Computer and operate in “PC master Software Mode”.  
To switch mode necessary to set jumpers JP108, JP109, JP110, JP111 as:  
1-2: “Standalone Mode” 
2-3: “PC master Software Mode” 
Jumper JP107 make switching analog signal "A_Speed" and "A_Temperature" (Refer Circuit 
diagram)  
1-2: “Speed” (measure analog signal from Speed set variable resistor) 
2-3: “Temperature”  (measure analog signal from temperature sensor inside IGBT module 
U203) 
It is recommended to set jumper JP107 to 1-2: “Speed” position when used “Standalone Mode” 
for motor speed control from variable resistor RV105, and to set jumper JP107 to 2-3: 
“Temperature” position when used “PC master Software Mode” for real time IGBT module 
U203 temperature monitoring via analog input SPEED (MC3PHAC, pin 26). 
Switching of jumpers in “Standalone Mode” and “PC master Software Mode” represents at 
fig.3 and fig.4. 
 

  
Fig. 3. 1-2: “Standalone Mode” Fig. 4. 2-3: “PC master Software Mode” 

 
 
By default jumpers JP107, JP108, JP109, JP110, JP111 set in position 1-2: “Standalone Mode” 
(Fig. 3). To use MJ-IMD-LC20-LC21 with personal computer jumpers must be switch to 
position 2-3: “PC master Software Mode” (Fig. 4). 
 



Software 
Before plugging USB cable to PC important to install Virtual COM Port (VCP) driver from 
FTDI website http://www.ftdichip.com/ 
For control and manage Control Board LC21 from personal computer possible to use 
FreeMASTER (refer “FreeMASTER Application Installation” on Freescale website 
http://www.freescale.com/) . 
Demo MC3PHAC FreeMASTER (also known as PC-Master) application software is available 
at http://www.freescale.com/ (refer AN2202: “Creating a Graphical User Interface (GUI) for 
the MC3PHAC” and AN2202SW software zip-file) 
 

Virtual COM port setup installation  
 
The Starter Kit MC3PHAC (Ver.2) connect to personal computer via USB. The Starter Kit use 
IC FT232RL - USB UART from FTDI, therefore it is necessary to install drivers of the virtual 
COM port (VCP Driver) or D2XX Driver, if user will use port via Windows USB Stack and 
DLL. last version of drivers it is possible to download from www.ftdichip.com. 
 
After VCP drivers installation will complete a new virtual COM port will appear in Windows 
Device Manager (Fig. 5).  

 
Fig. 5. FTDI VCP at Device Manager. 

 
It is possible to use this port (for example COM5 as a represent at Fig.5)to connect Starter Kit 
to any PC application. 
 



"FreeMASTER" installation 
 
Freescale company, as a manufacturer of IC MC3PHAC at the 
www.Freescale.com/FreeMASTER web site represents software: "FreeMASTER", well known 
before as a "PCmaster". 

 
Fig. 6. FreeMASTER main window. 

 
It is possible to download "FreeMASTER" description and help files for free from 
www.Freescale.com after registration.  
 

The "MC3PHAC_PCMasterSoftware_Demo" project 
FreeMASTER is a user-friendly real-time debug monitor and data visualization tool that you 
can use for any application development and information management. FreeMASTER supports 
completely non-intrusive monitoring of variables on a running system. You can display 
multiple variables changing over time on an oscilloscope-like display, or view the data in text 
form. As well, FreeMASTER supports additional capabilities and targets with an on-target 
driver for transmitting data from the target to the host computer. 
 
Freescale company at website www.Freescale.com also represents a demo-project for 
FreeMASTER: "MC3PHAC_PCMasterSoftware_Demo", refer to "Creating a Graphical User 
Interface (GUI) for the MC3 PHAC": AN2202.pdf. 
 
Important to note MC3PHAC_PCMasterSoftware_Demo needs to set the PWM polarity signal 
parameters and Dead Time value. If this parameters will set wring, the Starter Kit MC3PHAC 
(Ver.2) can be damage. To avoid this problem use the customized version of 
MC3PHAC_PCMasterSoftware_Demo.    
In customized version possible to found file "MotorInitParm.cfg", where parameters of the 
PWM polarity signals preset: 
 
PWM Polarity B+ T+ 0x1000 0x50 1 
Dead Time 0x0036 2000 ns 
 
These lines are set the PWM polarity signal parameters "B+ T+" and Dead Time value "2000 
ns" Other parameters can be different, depend configuration.  
It is not recommended to manually edit file "MotorInitParm.cfg". Parameters in this file saved 
from the project.  



 
Open the project MC3PHAC_PCMasterSoftware_Demo: File -> Open Project: 
 

 
Fig. 7. File -> Open Project window 

 
The open project is represents at fig. 8. 
 

 
Fig. 8. MC3PHAC_PCMasterSoftware_Demo main window 

 



At the next stage it is necessary to set COM port number for communication (Fig. 9). To set 
port those: Project -> Options... 

 
Fig. 9. COM port setting 

 
If COM port is change it is necessary to Save project by File -> Save Project. 
Now it is possible to connect to MC3PHAC by pushing red STOP Button. in the result in the 
bottom of the application data from MC3PHAC will appear (fig. 10): 

 

 
Fig. 10. Data from MC3PHAC. 

 



Next, press the button "Press Here to Continue" and note window will appear (fig. 10). Just 
close it by pressing OK . 

 
Fig. 11. Note window 

 

Next, system will show permission to execute ActiveX, click "Yes" : 

 

Fig. 12. Permission to execute ActiveX 
 



Before start the system will show one more time all parameters. It is important to check "PWM 
Polarity: B+ T+" and "Deadtime: 2000 ns" (Fig. 13): 

 

 
 

Fig. 13. Parameters window 
 

If parameters are different with described above, it is important to cancel by pressing "No" and 
set correspond value. Set parameters window represents at Fig. 14. 

 
Fig. 14. Set parameters window 

 



Set the corresponded parameters (most important to set PWM Polarity: B+ T+  and Deadtime: 
2000 ns) and press "Write Data to File"  in the result this data will write to file 
"MotorInitParm.cfg" and system will represents resume of all data which sawed in file (Fig. 15).  

 
Fig. 15. Saved Data Resume. 

 
Window after data downloading to MC3PHAC represents below (Fig.16): 
 

 
Fig. 16. Connect. 



At the next window it is enough to press Forward check box for start motor rotation (Fig. 17) 

 
Fig. 17. Motor is Run Forward. 

 
 

Using an independent Motor  
and Control Circuit power supply. 

 
Particular feature if the Power Board LC20 is possibility to use independent Motor and Control 
Circuit power supply connection. It is possible to use same voltage for Control Circuit and 
Motor IGBT Bridge U203 (refer Fig. 2) or to use separate "AC/DC Motor Power" and "AC 
Control Power" connection as represents at (Fig. 5) 
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Fig. 5. Separate "Motor Power" and  "Control Power". 
 

"AC Control Power" must be AC voltage 50/60 Hz, 220V, ±10%.  
"AC/DC Motor Power" can be AC voltage, in range 0 to 230V or DC voltage in range 0 to 
330V. In case of DC voltage "Motor Power" wiring "+" and "-" can be arbitrary because of 
rectifier D212 is on the board. Variable "Motor Power" useful in case of using motor with 
operation less than 220 volts or safety during tests and non-standard motor operation modes 
(like low-speed operation). 
 
The IC MC3PHAC measure Bus voltage "+V_MOTOR" at capacitor C219, via R210, R211, 
R212, R213, RV201, R214, R215, U202-A формируя аналоговый сигнал "A_VBUS". Signal 
"A_VBUS" going to IC MC3PHAC via jumper JP106 (position of jumper is 2-3: "Normal 
Operation"). In case of using low voltage "AC/DC Motor Power" it is necessary to set the 
jumper JP106 in position 1-2: "Voltage Sensor Emulation". In this case analog signal 
"A_VBUS" will be set by variable resistor RV101. For adjustment variable resistor RV101 it is 
recommended to connect Starter Kit MC3PHAC (Ver.2) to personal computer and check value 
of the "A_VBUS" signal by "Bus Voltage" data at the PC monitor (Fig. 6). 

 

Fig. 6. Bus Voltage Setting. 

Set the "Bus Voltage" using variable resistor RV101 around 100%. The adjustment of the 
variable resistor RV101 it is recommended to implement with disconnected "AC/DC Motor 
Power". Increasing of the "Bus Voltage" leads to the "BRAKE" signal appear, and further 
increasing leads to the "FAULT" signal appear. Value of "Bus Voltage" also influence to duty 
cycle of the PWM for make stable of actual motor voltage due to Bus Voltage changes or 
voltage ripple. 

Important to note, that setting of the jumper JP106 in position 1-2: "Voltage Sensor Emulation" 
in fact disconnect bus voltage checking by IC MC3PHAC and it is important to be carefully in 
using of the motor and board. It is recommended to use additional current limiters of fuses in 
the "AC/DC Motor Power". 

 

Set value around 100% 

by setting RV101 



Heatsink Mounting 
PCB size 100x105 mm 
Board must be installed on the Heatsink. Mounting holes location and dimension represents at 
Fig. 3, Side view represents at Fig. 4. 

 
Fig. 3. Mounting holes location 
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Fig. 4. Side view 
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